SINGLE EVENT NOISE MODEL (SENM)  
DESCRIPTION AND USER'S GUIDE

Mark R. Cosby  
Science Applications International Corporation  
1710 Goodridge Drive  
P.O. Box 1303  
McLean VA 22102

OCCUPATIONAL AND ENVIRONMENTAL HEALTH DIRECTORATE  
Bioenvironmental Engineering Division  
Noise Effects Branch  
2610 7th Street  
Wright-Patterson Air Force Base, OH 45433-7901

May 1996  

Approved for public release; distribution is unlimited.

19960531 050  
AIR FORCE MATERIEL COMMAND  
BROOKS AIR FORCE BASE, TEXAS
DISCLAIMER NOTICE

THIS DOCUMENT IS BEST QUALITY AVAILABLE. THE COPY FURNISHED TO DTIC CONTAINED A SIGNIFICANT NUMBER OF PAGES WHICH DO NOT REPRODUCE LEGIBLY.
NOTICES

When US Government drawings, specifications, or other data are used for any purpose other than a definitely related Government procurement operation, the Government thereby incurs no responsibility nor any obligation whatsoever, and the fact that the Government may have formulated, furnished, or in any way supplied the said drawings, specifications, or other data, is not to be regarded by implication or otherwise, as in any manner licensing the holder or any other person or corporation, or conveying any rights or permission to manufacture, use, or sell any patented invention that may in any way be related thereto.

Please do not request copies of this report from the Armstrong Laboratory. Additional copies may be purchased from:

National Technical Information Service
5285 Port Royal Road
Springfield, Virginia 22161

Federal Government agencies registered with the Defense Technical Information Center should direct requests for copies of this report to:

Defense Technical Information Center
Cameron Station
Alexandria, Virginia 22314

DISCLAIMER

This Technical Report is published as received and has not been edited by the Technical Editing Staff of the Armstrong Laboratory.

TECHNICAL REVIEW AND APPROVAL

AL/OE-TR-1994

This report has been reviewed by the Office of Public Affairs (PA) and is releasable to the National Technical Information Service (NTIS). At NTIS, it will be available to the general public, including foreign nations.

This technical report has been reviewed and is approved for publication.

ROBERT A. LEE
Chief, Noise Effects Branch

FOR THE DIRECTOR

LANCE J. BOLLINGER, LT COL, USAF, BSC
ACTING CHIEF, BIOENVIRONMENTAL ENGINEERING DIVISION
Armstrong Laboratory
Title: Single Event Noise Model (SEN M) Description and User's Guide

Author(s): Mr. Mark R. Cosby
Science Applications International Corporation

Performing Organization Name(s) and Address(es): SAIC
1710 Goodridge Drive
P.O. Box 1303
McLean Virginia 22102

Sponsoring/Monitoring Agency Name(s) and Address(es): Armstrong Laboratory
Occupational and Environmental Health Directorate
Bioenvironmental Engineering Division, Noise Effects Branch
2610 7th Street
Wright-Patterson Air Force Base, Ohio 45433-7901

12a. Distribution/Availability Statement
Approved for public release; distribution is unlimited.

13. Abstract (Maximum 200 words)
Public groups and some federal agencies are pressuring DoD to include single event noise and impulsive noise impact analyses in Environmental Impact Assessment Process (EIAP) documents. The Strategic Environmental Research and Development Program (SERDP) office funded an effort to improve and evaluate a single event noise model (SEN M) for aircraft noise. The validation of the SEN M included noise from subsonic and supersonic aircraft activity. This model provided a defensible analytical approach to assess single event noise impacts generated by DoD operations and will aid in complying with the National Environmental Policy Act (NEPA). The basis of the SEN M is a noise program previously developed with Advanced Research Project Agency funding. The program was originally developed for underwater acoustics and was recently converted to atmospheric acoustics. Development of this program directly supports the tri-service strategic plan for the compliance pillar of research and development objective of developing improved assessment tools related to environmental management. It assists DoD in producing defensible EIAP documents concerning noise generated in sensitive areas such as parks and wilderness areas. This report is a user's manual describing the SEN M that was developed under this SERDP project.

14. Subject Terms
Aircraft Noise, Environment, Impulse, Noise, Noise Prediction, Noise Propagation

15. Number of Pages
44

16. Price Code

17. Security Classification of Report
UNCLASSIFIED

18. Security Classification of This Page
UNCLASSIFIED

19. Security Classification of Abstract
UNCLASSIFIED

20. Limitation of Abstract
UNLIMITED

NSN 7540-01-280-5500
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>2.0</td>
<td>DESCRIPTION OF THE COMPUTATIONAL MODEL</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>2.1 General</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>2.2 Propagation Algorithms</td>
<td>3</td>
</tr>
<tr>
<td></td>
<td>2.3 Sound Calculations</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>2.4 Parameterization of Inputs and Outputs</td>
<td>10</td>
</tr>
<tr>
<td>3.0</td>
<td>EXECUTION OF THE COMPUTATIONAL MODEL</td>
<td>13</td>
</tr>
<tr>
<td>4.0</td>
<td>DESCRIPTION OF THE GRAPHICAL MODEL AND EXECUTION INSTRUCTIONS</td>
<td>19</td>
</tr>
</tbody>
</table>
## List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 2.1-1</td>
<td>Original SPL Scaled to 12,700 lbs/hr</td>
<td>2</td>
</tr>
<tr>
<td>Figure 2.3-1</td>
<td>SENM A-weighted sound level calculation</td>
<td>8-9</td>
</tr>
<tr>
<td>Figure 3.0-1</td>
<td>Parameter input file</td>
<td>14</td>
</tr>
<tr>
<td>Figure 3.0-2</td>
<td>Source routes file</td>
<td>15</td>
</tr>
<tr>
<td>Figure 3.0-3</td>
<td>Source SPL input file</td>
<td>16</td>
</tr>
<tr>
<td>Figure 3.0-4</td>
<td>Output log file</td>
<td>17</td>
</tr>
<tr>
<td>Figure 3.0-5</td>
<td>Sample Analysis</td>
<td>18</td>
</tr>
<tr>
<td>Figure 3.0-6</td>
<td>Output plpos file</td>
<td>18</td>
</tr>
<tr>
<td>Figure 4.0-1</td>
<td>Main Window</td>
<td>19</td>
</tr>
<tr>
<td>Figure 4.0-2</td>
<td>Window Attributes</td>
<td>21</td>
</tr>
<tr>
<td>Figure 4.0-3</td>
<td>Tear-off Menu with Window Menu on</td>
<td>22</td>
</tr>
<tr>
<td>Figure 4.0-4</td>
<td>File menu</td>
<td>22</td>
</tr>
<tr>
<td>Figure 4.0-5</td>
<td>Information Dialog Box</td>
<td>23</td>
</tr>
<tr>
<td>Figure 4.0-6</td>
<td>File Subsystem Dialog Box</td>
<td>23</td>
</tr>
<tr>
<td>Figure 4.0-7</td>
<td>Error Dialog Box</td>
<td>24</td>
</tr>
<tr>
<td>Figure 4.0-8</td>
<td>Reading the SPL Map File</td>
<td>25</td>
</tr>
<tr>
<td>Figure 4.0-9</td>
<td>Converting SPLs to Color Values</td>
<td>26</td>
</tr>
<tr>
<td>Figure 4.0-10</td>
<td>First SPL Map Image</td>
<td>26</td>
</tr>
<tr>
<td>Figure 4.0-11</td>
<td>View Menu</td>
<td>27</td>
</tr>
<tr>
<td>Figure 4.0-12</td>
<td>Information Dialog Box</td>
<td>28</td>
</tr>
<tr>
<td>Figure 4.0-13</td>
<td>Last SPL Map Image</td>
<td>28</td>
</tr>
<tr>
<td>Figure 4.0-14</td>
<td>Options Menu</td>
<td>29</td>
</tr>
<tr>
<td>Figure 4.0-15</td>
<td>Sound Floor Range</td>
<td>30</td>
</tr>
<tr>
<td>Figure 4.0-16</td>
<td>SPL Map Image with Set Sound Floor</td>
<td>30</td>
</tr>
<tr>
<td>Figure 4.0-17</td>
<td>Speed Dialog</td>
<td>31</td>
</tr>
<tr>
<td>Figure 4.0-18</td>
<td>Toggles Dialog</td>
<td>32</td>
</tr>
<tr>
<td>Figure 4.0-19</td>
<td>SPL Map Image with Terrain Contour Overlay</td>
<td>33</td>
</tr>
<tr>
<td>Figure 4.0-20</td>
<td>SPL Map Image in Proportional Mode</td>
<td>33</td>
</tr>
<tr>
<td>Figure 4.0-21</td>
<td>AL Map Image with Microphones and Terrain</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Contour Overlays</td>
<td></td>
</tr>
</tbody>
</table>
DESCRIPTION AND USER'S GUIDE FOR
THE SINGLE EVENT NOISE MODEL (SENM)

1.0 OVERVIEW

The Single Event Noise Model (SENM) is an interactive, dynamic aircraft noise assessment tool being developed for the U.S. Air Force Armstrong Laboratory at Wright Patterson Air Force Base. SENM's purpose is to provide a credible representation of the physics of atmospheric sound propagation, of sound interaction with terrain and structures, and high resolution 3-D graphical depiction's of noise fields with simultaneous display of the terrain. SENM is comprised of two separate models functionally integrated via their databases. The first will be referred to as the computational model and the second as the graphical model. The computational model can be used as a stand alone analysis tool or used to generate input data for the graphical model. The graphical model is used to animate and visualize the A-weighted sound level (AL) data generated by the computational model for analysis and demonstration of noise field characteristics and influences.

Both the computational and graphical models are written in ANSI C with all function calls prototyped. As such, both applications are portable to all major UNIX workstation vendors including DEC, HP, IBM, SGI, and SUN. Current implementations include SUN Sparc and SGI Indigo platforms. The graphic data visualization tool uses the Motif 1.2.3 tool kit and X11R5 for display.

2.0 DESCRIPTION OF THE COMPUTATIONAL MODEL

2.1 General

The SENM model referred to in this section will be the computational model unless otherwise noted. SENM predicts noise levels from aircraft and the measurements that would be obtained if noise levels were monitored in real-time by microphones on the ground. SENM makes adjustments to the input sound pressure level (SPL) for each aircraft contributing to sound levels at the simulated point of measurement, based on physical phenomena that alter the propagation of aircraft noise. SENM accounts for the temperature, relative humidity, wind direction, and wind speed within its propagation algorithms. The propagation phenomena modeled are spherical spreading, terrain masking, shadow zones, ground impedance, and atmospheric absorption.
The aircraft source is specified quantitatively as sound pressure level spectra, normalized to some reference distance, as a function of frequency and aspect angle with respect to the flight path for a given power setting. Typical source input data has been obtained from military ground runup data. SENM linearly interpolates the source SPL between measurement point aspect angles to provide angular continuity in acoustic signature representation. Figure 2.1-1 depicts a representative aircraft acoustic signature characterization used in SENM. The source positions over time are input separately as described in section 2.4. Cylindrical symmetry of the source acoustic signature is assumed. Each aircraft may have multiple power settings. The power setting is included with each input position point and can change with each position point. SENM handles multiple aircraft simultaneously.

Figure 2.1-1 Original SPL Scaled to 12,700 lbs/hr

SENM calculates the A-weighted sound level at each time step for every grid point requested. Data is calculated for 24 one-third octave band centers (50 Hz - 10,000 Hz). The user decides whether to generate data for an entire grid area or for individual grid points. The grid area is defined by the user and divided into individual grid points. The AL is calculated and stored for each grid point for each time step. This entire set of AL values for each grid point and time step is referred to as the SPL map and is stored as a binary file. The SPL map is displayed graphically in
the graphical model described in section 4.0. The sound exposure level (SEL) is also calculated at the end of a simulation run for each grid point and stored as a binary map.

2.2 Propagation Algorithms

The loss of signal power as the signal propagates from the source to the sensor must be accounted for. Detailed physical models and in-depth understanding of propagation loss effects involve basic research questions in aircraft acoustics. The SENM implementation successfully compromises between computational efficiency while adequately accounting for the important phenomenological variability in the effects. SENM is effective in capturing first-order performance characteristics of acoustic environments. The refinement and calibration of the propagation representation in SENM is a continuing emphasis area for further enhancement.

Propagation phenomena that affect signal strength include spherical spreading, atmospheric absorption, ground impedance effects, shadow zone effects, and terrain masking. Only spherical spreading and atmospheric absorption are well enough understood to model with high confidence. Spherical spreading is frequency-independent and produces $1/R^2$ acoustic power loss with range $R$. Atmospheric absorption is frequency-dependent and SENM uses the SAE Standard to represent this effect. The loss due to absorption is calculated using the band center frequency for each of the 24 one-third octave bands.

A model for ground impedance effects near to the sensor is also included. The basic model accounts for the impedance difference between the air and the local ground. The gain in signal power due to the presence of an interface is

$$1 + \rho(f)e^{\frac{2\pi\Delta}{c}}$$

where $c$ is the speed of sound (as a function of temperature), $\rho$ is a frequency-dependent complex reflection coefficient, and $\Delta$ is the path length difference between a direct ray from the source to the receiver and a ground-reflected ray.

The reflection coefficient is

$$\rho = \frac{\sin \theta_s - \frac{Z_1}{Z_2}}{\sin \theta_s + \frac{Z_1}{Z_2}}$$
where $\theta_i$ is the elevation angle from the sensor to the emitter,

$$\frac{Z_2}{Z_1} = R_2 + jX_2$$

$$R_2 = 1 + 9.08 \left( \frac{f}{\sigma_{flow}} \right)^{0.75}$$

and

$$X_2 = 11.9 \left( \frac{f}{\sigma_{flow}} \right)^{0.73}$$

where $\sigma_{flow}$ is flow resistivity. Flow resistivity values can range from several tens to a few thousand, depending upon the surface. Very high numbers correspond to hard reflective surfaces like macadam. The flow resistivity is a user defined parameter in SENM. The impact of the surface can be studied parametrically by analyzing the effect on the results of changing this parameter.

The path length difference is

$$\Delta = \sqrt{d^2 + (h_s + h_r)^2} - \sqrt{d^2 + (h_s - h_r)^2}$$

where $d$ is the separation of the source and receiver along the ground, $h_s$ is the source height, and $h_r$ is the receiver height above the ground.

The ground impedance model used alone tends to overestimate signal loss for very low elevation angles. The ground effect loss is probably not actually overestimated, but other effects such as acoustic scattering in a turbulent atmosphere may cause the sound to be more intense than that predicted by a model that considers the ground impedance effect only. Because of this, the ground impedance model includes logic to limit losses due to the ground effect at very low source-to-receiver elevation angles. The loss term is clamped at the value for $\phi_g$ if the actual elevation angle is less than $\phi_g^\circ$. $\phi_g$ is a user defined parametric threshold in SENM. As with other frequency-dependent factors, the performance model calculates the loss (or gain) due to ground effect using the band center frequency for each of the 24 one-third octave bands.
Other propagation effects are even more complex to represent in the model. The first of these complex phenomena is the signal loss due to terrain masking. For that, we include a single parameter $L_{TM}$. When (acoustic) line of sight is lost, the signal will loose $L_{TM}$ dB relative to what it would have been if there were no loss of line of sight. A typical value for $L_{TM}$ from field test data is 10 dB. $L_{TM}$ is a user defined parameter in SENM. Better models for signal levels when line of sight is lost can be inserted into SENM when accredited to be better then the field data extrapolations.

Another important complex phenomenon to model is shadow zones and propagation into shadow zones. Shadow zone formation and characterization depend largely upon temperature and wind profiles. The temperature profile effects are isotropic; that is, the shadow or ducting effect does not depend upon the orientation of the source and receiver, only upon the temperature profile and relative heights of the source and receiver. However, wind effects are not isotropic. They depend on the direction of propagation relative to the wind as well as the vertical temperature profile of the wind. The overall effect is that when the wind blows from the source toward the receiver the sound is louder than when the wind blows in the other direction. Crosswinds present minimal effects. Ray theory predicts no propagation into a shadow zone. In fact, there is significant signal in the shadow zone. SENM calculations account for these factors with five parameters. These are $L_{sz}$, $dw/dz$, $\theta_w$, $w_0$, and $dc_T/dz$. Signal strength in a shadow zone is decreased by the user defined value of $L_{sz}$ dB from what it would have been without the shadow zone.

The other four parameters are used to determine, for the given source-receiver configuration, if there is a shadow zone. Parameters are: the derivative of wind speed with respect to altitude, $dw/dz$; the wind direction, $\theta_w$; the wind speed close (at 1 meter elevation) to the ground, $w_0$; and the gradient of sound speed with respect to altitude, $dc_T/dz$, which is actually caused by the gradient of temperature as a function of altitude. The model is applied with the assumption of a constant gradient of wind and sound speed with altitude for the emitter. The equation for the distance from the source to the shadow zone is

$$d_s = \sqrt{\frac{2(c_0 + w_0 \cos(\theta - \theta_w))}{\left(\frac{dc_T}{dz} + \frac{dw}{dz}(\cos(\theta - \theta_w))\right)\left(\sqrt{h_s} + \sqrt{h_r}\right)}}$$
where \( \theta \) is the direction of sound propagation, the direction from the source to the sensor. This is a standard result. ("The shadow zone in a stratified medium," R. Makarewicz, JASA V85, N3, March 1989, pp1092-1096).

The adiabatic temperature lapse rate is -9.8 degrees per kilometer. The speed of sound (in meters per second) varies as the square root of the temperature in Kelvin but can be approximated as changing by 0.61 times the Centigrade temperature in the temperature region of interest. Thus, for normal lapse conditions, the nominal value to use for \( \frac{dc_f}{dz} \) is \( 0.61 \times (-9.8) = 6.0 \) meters/sec/km or -0.006 m/s/m.

Selection of a wind speed and gradient is more difficult, especially since a logarithmic, not linear, change in wind speed with altitude may be more physically accurate. Our primary rationale for using the linear model as the default representation in SENM is the need to approximate the wind over only a small range of altitudes and the linear model supports a closed form expression for the distance to the shadow zone. The wind gradient should be selected to represent the average conditions between the sensor and the aircraft heights. Aircraft altitude can have a significant effect. The gradient up to 50 meters in altitude is about 0.06 m/s/m. Up to 100m it is approximately half that value. This is for a fairly substantial ground-level wind of about 10m/s (about 20 knots). At least for winds this high, clearly the wind effect is more important than the temperature effect and the nonlinear (perhaps logarithmic) variation of wind speed with altitude is justified. For initial studies we suggest using the above values for 50- and 100-meter emitters in a 20-knot wind, scaling the values with wind speed for other speeds, and reducing the average wind gradient by 1/2 for every doubling of aircraft altitude.

Except for the spherical spreading and atmospheric absorption models, all the propagation model elements described above are intended to be useful working hypotheses for the purpose of noise impact studies and SENM accreditation for specific uses.

2.3 Sound Calculations

SENM calculates the A-weighted sound level for each grid point and time step as well as the sound exposure level for each grid point at the end of the simulation. Both sets of values are output as binary files that can be visualized using the graphical model. Figure 2.3-1 shows the logical flow of the AL calculations within SENM.
All the propagation effects discussed in the previous section create either a dB loss or gain at the point of measurement. These are combined with the input source position, orientation and SPL (dB) at the appropriate frequency and aspect angle yielding the SPL occurring at a specific time and grid point. In order to obtain the SPL with exponentially weighted time averaging, the value is approximated by using four instantaneous samples and smoothing them with weighting factors. These weighting factors were derived by Dr. W. J. Galloway and can be seen in the following equation.

\[
SSPL_{k,n,j} = 0.39 \times SPL_{k,n,j} + 0.27 \times SSPL_{k-1,n,j} + 0.21 \times SSPL_{k-2,n,j} + 0.13 \times SSPL_{k-3,n,j}
\]

where \( k \) is the current time step, \( n \) is the grid point, and \( j \) is the frequency band index. SSPL represents the smoothed SPL. Smoothing is done once \( k \) is greater than 3. The smoothed SPL values are then combined with the appropriate A-weighting relative frequency response (dB) resulting in an A-weighted SPL for each frequency, grid point, and time step.

\[
AWSSPL_{k,n,j} = SSPL_{k,n,j} + AW_j
\]

where \( AW_j \) is the relative frequency response for A-weighting for frequency band \( j \). These A-weighted SPL values for each frequency are then combined to yield the A-weighted sound level for each grid point and time step.

\[
AL_{k,n} = 10 \times \log \left( 10 \times \frac{\sum_j AWSSPL_{k,n,j}}{10} \right), \quad j=17,40.
\]

The SEL is the combination of the AL values from all time steps for each grid point;

\[
SEL_{n} = 10 \times \log (\Delta t) + 10 \times \log \left( 10 \times \frac{\sum_k AL_{k,n}}{10} \right), \quad k=\text{first time step, last time step}
\]

where \( \Delta t \) is the time step size (currently 0.5 seconds). It is understood that for high velocity (>350kts) emitters the 0.5 second time step does not offer the spatial or temporal resolution necessary to resolve the emitter as a point (vice a line) source. This source of distortion in model output is believed to be minimal at this time, but should be investigated against flight profile data for maneuvering and accelerating emitters.
Time = Start Time

Is Time > End Time?

No
N=1

Is N > Map Array Size?

No
Get Receiver Location
Calculate retarded signal emission time
Get Source location & noise power parameters
Compute frequency independent losses and gains
(FreqInd = Geometry + Line Of Sight + Shadow Zone)

FreqBand Cr = 17

Is FreqBand Cr > 40

No

Compute frequency dependent losses and gains
(FreqDep = Source + Ground permeance + Atmospheric Absorption)
Approximate the exponential time weighting by using 4 instantaneous samples and smoothing w/ weighting factors:
\[
SPL(\text{Time}, N) = 0.39 \times (\text{FreqInd} + \text{FreqDep}) + 0.27 \times SPL(\text{Time} - 1, N) + 0.21 \times SH(\text{Time} - 2, N) + 0.13 \times SH(\text{Time} - 3, N)
\]

Add A-weighted factor for this FreqBand:
\[
AWSPL(\text{Time}, N) = SPL(\text{Time}, N) + \text{AWeight(FreqBand)}
\]

Update the sum of the A-weighted SPL values:
\[
\text{SumAWSPL(\text{Time}, N)} = \text{SumAWSPL(\text{Time}, N)} + 10^{\times 10^{-2}}(AWSPL(\text{Time}, N)/10)
\]

Calculate Overall A-weighted SPL:
\[
\text{OverallAWSPL(\text{Time}, N)} = 10 \times \log(\text{SumAWSPL(\text{Time}, N)})
\]

Send Overall A-weighted SPL value for this Time & grid point to map storage

Increment N

Increment Time

STOP

Figure 2.3-1 SENM A-weighted sound level calculation
2.4 Parameterization of Inputs and Outputs

SENM is driven by one main input parameter file. It is entered as a command line input to the model (the first of two command line inputs). A detailed description of executing the model can be found in section 3.0. The parameter file includes the names of other files required as input for a particular run of SENM. The number of input files varies but will always include the parameter file, an aircraft route file, and at least one source SPL file. Other optional input files are a terrain map and additional source SPL files for multiple power settings. There are four output files generated. The user defines a prefix file name for each of the output files in the parameter file. The output files are Prefix.log, Prefix.map, Prefix.plpos, and Prefix.avg.

Input Files:
Parameter File

- Simulation start time, simulation end time, simulation time step (currently must be 0.5 seconds)
- Grid map specifications: Resolution of each grid point, X & Y dimensions, Map center (both in X,Y and Lat,Lon) or XYZ location for specific grid points
- Terrain map specifications: Number of X & Y points, Resolution of each grid point
- Output file prefix
- Input file names
- Observation height (microphone height above the ground)
- Air temperature and relative humidity
- Terrain masking Power Loss (if the sound path between the source and the receiver is masked by the terrain this value is used as a dB loss in signal strength)
- Shadow Zone Signal Strength Loss (if the sound path between the source and the receiver propagates into a shadow zone this value is used as a dB loss in signal strength)
- Wind direction and speed
- Flow resistivity constant (this value is used to describe the surface over which the aircraft is flying; grass, dirt, etc.)
- Sine of the minimum elevation angle used for the ground impedance algorithm (typically the minimum elevation angle is 2.5 degrees)
- Delta time for tolerance checks (this value is used when calculating the time at which the sound that is heard is actually emitted)
- Reference distance from source (this value corresponds to the source runup SPL input data)
Terrain Map File

This file contains the altitude at equally spaced points across a defined area. The inputs for
the defined terrain map grid area are entered in the parameter file. This file contains n x m values
(altitudes).

Aircraft Route File

- Aircraft ID
- Time, X, Y, Z, and power setting (There is a separate line of this format for each aircraft
position recorded. A cubic spline algorithm is used to interpolate between two input
positions.)

Source SPL File

This file contains sound pressure levels from runup data for a given power setting. The
power settings recognized by SENM are: AfterBurner, Takeoff, Approach, Intermediate, and
Maximum. Different SPL files can be used at different points of each aircraft’s flight. The power
settings are specified in the aircraft route file at each defined point along the flight of the aircraft.
Each source SPL file contains 24 lines of 19 SPL values per line. Each line represents one of the
24 one-third octave bands. Each column represents aspect angles of 0, 10, 20, ... 180 Degrees.

Output Files:
Prefix.log

This file contains a log of many simulation events including most error messages produced
by SENM. The amount of data output to this file is controlled by the second (and last) command
line input, either "true" or "false". A "false" command line input will output only the major
simulation events such as aircraft positions, aircraft additions and removals from the simulation,
aircraft power setting changes, and error messages.

A "true" command line input will output a lot of data for each grid point, simulation time
step, and frequency. This data is useful when analyzing single grid points as is the case when
comparing against real world microphone data. A sample log file and description can be found in
section 3.0.
Prefix.map

This is a binary file containing the A-weighted sound level for each grid point requested by the user for every simulation time step. This file is displayed for visualization by the graphical model described in section 4.0. The data are stored as binary unsigned characters since the values fall between 0 and 255.

Prefix.plpos

This file contains each aircraft's XYZ position for each simulation time step.

Prefix.avg

This is a binary file containing the sound exposure level for each grid point requested by the user. The data are stored as binary unsigned characters since the values fall between 0 and 255.
3.0 EXECUTION OF THE COMPUTATIONAL MODEL

SENM input is controlled from the input parameter file. This file is entered as the first of two command lines inputs when executing the model. The second command line input is either "true" or "false" and controls the amount of data output to the Prefix.log file. There are two different modes of operation using SENM. Mode I generates data for an entire grid area defined by the user in the parameter file. When operating in this mode, a command line input of "false" should be used. A "true" command line input could potentially lead to hundreds of megabytes of unused data. Mode II generates data for one grid point (or a small number of grid points). This mode is useful when analyzing the output at a specific microphone location, band by band. A "true" command line input is used to output the detailed band by band data. Both modes are described in this section.

SENM is executed by the following command line:

%SENM  parameter_file_name  true

A sample parameter input file can be found in Figure 3.0-1. The user can edit the parameter file using any editor available. It is stored as an ASCII file. Any parameter can be altered by the user. Most inappropriate values trigger an error message in the log file and execution is halted. If the simulation start and end time exceeds the aircraft's flight, simulation is limited to the beginning and ending time of the aircraft(s). If the aircraft's flight exceeds the simulation time interval, the simulation time interval is adhered to. This allows for analyzing specific time intervals. The input time step must currently be set to 0.5 seconds to allow for proper smoothing equations approximating the exponential time averaging of the AL.

If running in mode I, the "Number of Specific XYZ Points" should be set to 0 and no values should be entered. If running in mode II, the desired number of points should be entered as the "Number of Specific XYZ Points" and an XYZ value for each point should follow, one point per line. The XYZ values are in meters and should be referenced to the same origin as the values in the aircraft routes file.

The names of the other input files required for each run and the prefix of each of the output files are entered in the parameter file. The file names should include appropriate directory names as well. The prefix name should also include the proper directory where the file is to be stored. This is especially important when operating in mode I and generating SPL maps for use with the graphical model.
Sample parameters input file:

Processing Time Interval
- Start Time: 5520 seconds
- End Time: 51840 seconds
- Update Interval: 0.5 seconds

Power Map Parameters
- Map Scale (Resolution): 50 meters
- Map Range X (X Axis): 20000 meters
- Map Range Y (Y Axis): 5000 meters
- Map Center: 0.0 0.0 meters
- Lat, Lon of Map Center: 40.0 -110.0 Degrees
- Number of Specific XYZ Points: 1
  - 0.0 0.0 0.0

Terrain Map Parameters
- Number of X Points: 0 meters
- Number of Y Points: 0 meters
- Map Delta X: 90 meters
- Map Delta Y: 90 meters

Output/Input Files
- Output Prefix (*.log,*.map,*.plpos,*.avg): `/home/SENM/output/PREFIX_Goes_Here`
- Terrain Map Input File Name: None
- Airplane Route Input File Name: `/home/SENM/SOURCE_INPUT/Aircraft_track_mod5.rts`
- AfterBurner SPL Input File Name: None
- Takeoff SPL Input File Name: `/home/SENM/SOURCE_INPUT/norm_SP1.out`
- Approach SPL Input File Name: None
- Intermediate SPL Input File Name: None
- Maximum SPL Input File Name: None

Miscellaneous Parameters
- Observation Height: 1.2192 meters
- Air Temperature: 50.0 Degrees Fahrenheit
- Relative Humidity of Air: 49.0 Percent
- Terrain Masking Power Loss: -10.0 dB
- Shadow Zone Signal Strength Loss: -10.0 dB
- Wind Direction: 3.49 rad
- Wind Speed: 4.63 meters/sec
- Flow Resistivity (Sigma Flow): 200.0
- Sin of MinElv for Ground Impedance: 0.0436 /* Min. elev. angle 2.5 deg.*

Delta Time for tolerance checks: 0.1 sec
Reference distance from source: 76.2 meters /* 250 ft*/

Figure 3.0-1 Parameter input file

The graphical model uses the same parameter input file and finds its input SPL maps using the output prefix found in the parameter file.
The aircraft routes file may contain multiple aircraft. The data for the second aircraft is appended after the data for the first, and so on. A sample routes file can be found in Figure 3.0-2. The power setting in the sample file is "Takeoff". Use of this file requires an input file to be entered in the parameter file as "Takeoff SPL Input File Name." Different power settings can be set for any time step entered in the routes file. Each power setting requires a corresponding source SPL file. A sample source SPL file can be found in Figure 3.0-3. The time in the routes file is seconds, the XYZ points are in meters. The routes file can be of any length to accommodate the flight of the aircraft.

<table>
<thead>
<tr>
<th>Aircraft ID</th>
<th>9.6 , 7.78</th>
<th>-11627.88</th>
<th>404.68</th>
<th>399.12</th>
<th>Takeoff</th>
</tr>
</thead>
<tbody>
<tr>
<td>50696.00</td>
<td>-11607.83</td>
<td>394.63</td>
<td>397.52</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50696.50</td>
<td>-11587.77</td>
<td>384.62</td>
<td>396.01</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50696.75</td>
<td>-11567.71</td>
<td>374.65</td>
<td>394.60</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50697.00</td>
<td>-11547.65</td>
<td>364.71</td>
<td>393.28</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50697.25</td>
<td>-11527.60</td>
<td>354.82</td>
<td>392.05</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50697.50</td>
<td>-11507.54</td>
<td>344.97</td>
<td>390.91</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50697.75</td>
<td>-11487.49</td>
<td>335.15</td>
<td>389.87</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50846.75</td>
<td>5280.04</td>
<td>-266.60</td>
<td>315.47</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50847.00</td>
<td>5346.79</td>
<td>-265.73</td>
<td>318.56</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50847.25</td>
<td>5413.67</td>
<td>-264.78</td>
<td>322.39</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50847.50</td>
<td>5480.67</td>
<td>-263.77</td>
<td>326.99</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50847.75</td>
<td>5547.80</td>
<td>-262.67</td>
<td>332.38</td>
<td>Takeoff</td>
<td></td>
</tr>
<tr>
<td>50848.00</td>
<td>5615.06</td>
<td>-261.51</td>
<td>338.56</td>
<td>Takeoff</td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3.0-2 Source routes file**

The values in the source SPL files are sound pressure levels in dB. Each line represents the value for each of the band center frequencies for each of the 24 one-third octave bands. Each column represents aspect angles with respect to the flight path of 0 to 180 degrees (every 10 degrees).

During execution of SENM, the simulation clock time is output to the screen. This allows the user to follow the progress of a run. A typical run operating in mode I for one aircraft, 300 time steps, and 40,000 grid points on a SPARC 10 model 41 (40 MHz Super Sparc processor) is 13 hours. The same run on a Silicon Graphics Indigo Elan (50/100 MHz R4000 processor) is 10 hours. Run times for analyzing specific single grid points are a few seconds. Detailed analysis of single points should be run in mode II due to the prohibitive size of the output log file and run time when operating in mode I.
| 84 | 85 | 87 | 87 | 88 | 89 | 90 | 91 | 92 | 93 | 95 | 97 | 102 | 108 | 112 | 113 | 109 | 99 | 89 |
| 86 | 87 | 89 | 89 | 90 | 91 | 92 | 91 | 94 | 95 | 97 | 99 | 106 | 111 | 117 | 116 | 111 | 101 | 91 |
| 88 | 89 | 91 | 91 | 91 | 91 | 93 | 94 | 95 | 96 | 98 | 101 | 108 | 115 | 120 | 118 | 112 | 102 | 92 |
| 90 | 91 | 93 | 93 | 93 | 93 | 94 | 94 | 95 | 95 | 98 | 100 | 103 | 110 | 116 | 122 | 119 | 113 | 103 | 93 |
| 93 | 94 | 94 | 94 | 94 | 94 | 95 | 96 | 96 | 99 | 101 | 105 | 112 | 116 | 123 | 121 | 124 | 114 | 94 |
| 96 | 96 | 96 | 96 | 96 | 96 | 97 | 98 | 99 | 102 | 107 | 115 | 118 | 121 | 122 | 115 | 105 | 95 |
| 95 | 96 | 96 | 96 | 96 | 97 | 95 | 97 | 97 | 98 | 103 | 108 | 117 | 122 | 119 | 122 | 115 | 105 | 95 |
| 93 | 97 | 98 | 98 | 98 | 98 | 96 | 97 | 97 | 98 | 104 | 109 | 116 | 124 | 122 | 120 | 114 | 104 | 94 |
| 96 | 101 | 100 | 100 | 99 | 98 | 96 | 97 | 97 | 99 | 104 | 118 | 118 | 121 | 123 | 118 | 113 | 103 | 93 |
| 104 | 105 | 105 | 105 | 101 | 99 | 96 | 98 | 97 | 101 | 105 | 110 | 117 | 122 | 121 | 118 | 111 | 101 | 91 |
| 102 | 108 | 108 | 108 | 104 | 102 | 99 | 99 | 98 | 102 | 105 | 110 | 117 | 121 | 120 | 116 | 109 | 99 | 89 |
| 101 | 106 | 108 | 108 | 105 | 105 | 102 | 100 | 100 | 101 | 104 | 109 | 114 | 119 | 117 | 113 | 107 | 97 | 87 |
| 98 | 104 | 105 | 105 | 103 | 104 | 102 | 100 | 101 | 100 | 102 | 106 | 113 | 116 | 115 | 111 | 104 | 94 | 84 |
| 96 | 101 | 104 | 104 | 101 | 102 | 100 | 100 | 100 | 99 | 103 | 105 | 111 | 114 | 112 | 109 | 102 | 92 | 82 |
| 95 | 99 | 102 | 102 | 100 | 101 | 100 | 102 | 101 | 102 | 105 | 106 | 109 | 114 | 111 | 110 | 102 | 92 | 82 |
| 93 | 96 | 100 | 100 | 98 | 100 | 101 | 103 | 102 | 104 | 107 | 108 | 110 | 114 | 111 | 110 | 103 | 93 | 83 |
| 90 | 94 | 97 | 97 | 97 | 99 | 100 | 102 | 102 | 103 | 107 | 108 | 111 | 114 | 111 | 108 | 103 | 93 | 83 |
| 88 | 92 | 96 | 96 | 96 | 98 | 98 | 99 | 100 | 102 | 104 | 106 | 110 | 112 | 110 | 106 | 101 | 91 | 81 |
| 87 | 91 | 95 | 95 | 95 | 97 | 98 | 100 | 100 | 101 | 104 | 106 | 109 | 112 | 110 | 106 | 99 | 89 | 79 |
| 84 | 88 | 93 | 93 | 93 | 94 | 95 | 97 | 98 | 99 | 102 | 104 | 107 | 110 | 107 | 104 | 97 | 87 | 77 |
| 82 | 86 | 91 | 91 | 91 | 93 | 94 | 96 | 96 | 98 | 101 | 102 | 106 | 109 | 106 | 103 | 96 | 86 | 76 |
| 79 | 83 | 89 | 89 | 88 | 90 | 92 | 94 | 95 | 96 | 99 | 101 | 104 | 109 | 106 | 101 | 94 | 84 | 74 |
| 75 | 79 | 86 | 86 | 84 | 87 | 89 | 91 | 91 | 93 | 96 | 98 | 102 | 107 | 104 | 99 | 91 | 81 | 71 |
| 72 | 75 | 82 | 82 | 80 | 83 | 85 | 87 | 88 | 90 | 94 | 97 | 102 | 107 | 104 | 99 | 89 | 79 | 69 |

**Figure 3.0-3 Source SPL input file**

A sample log file generated in mode II (using "true" as the second command line input) can be found in Figure 3.0-4. The data in the sample file is from two time steps only. The log file contains similar data for each time step. The "Overall A-weighted SPL" value at the end of the data for each time step is the AL output to the SPL map file. Each line of data starting with "Src" represents one of the 24 frequencies. The data contained in this file is:

- **Geom:** dB loss due to spherical spreading
- **LOS:** dB loss due to terrain masking
- **SZ:** dB loss due to shadow zones
- **Src:** Source input SPL (dB)
- **Grnd:** dB gain due to ground impedance
- **Acf:** atmospheric absorption coefficient
- **Atm:** dB loss due to atmospheric absorption
- **RawSPL:** combination of Src, Geom, LOS, SZ, Grnd, and Atm
- **SPL:** RawSPL that has been smoothed to approximate exponentially weighted time averaging
- **A-Weight SPL:** SPL after applying the relative frequency response for A-weighting
- **Overall A-weighted SPL:** A-weighted Sound Level
<table>
<thead>
<tr>
<th>Source</th>
<th>Grade</th>
<th>Acf</th>
<th>Amplitude</th>
<th>Raw SPL</th>
<th>A-Weighted SPL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Src= 91.6</td>
<td>Gm= 0.6</td>
<td>Acf= 0.1</td>
<td>Atm= -4.9</td>
<td>Raw SPL= 31.5</td>
<td>A-Weighted SPL= 1.3</td>
</tr>
<tr>
<td>Src= 93.6</td>
<td>Gm= 0.6</td>
<td>Acf= 0.1</td>
<td>Atm= -6.1</td>
<td>Raw SPL= 32.2</td>
<td>A-Weighted SPL= 6.0</td>
</tr>
<tr>
<td>Src= 94.6</td>
<td>Gm= 0.5</td>
<td>Acf= 0.2</td>
<td>Atm= -7.8</td>
<td>Raw SPL= 31.5</td>
<td>A-Weighted SPL= 9.0</td>
</tr>
<tr>
<td>Src= 95.6</td>
<td>Gm= 0.5</td>
<td>Acf= 0.2</td>
<td>Atm= -9.7</td>
<td>Raw SPL= 30.6</td>
<td>A-Weighted SPL= 11.5</td>
</tr>
<tr>
<td>Src= 96.6</td>
<td>Gm= 0.5</td>
<td>Acf= 0.3</td>
<td>Atm= -12.2</td>
<td>Raw SPL= 29.1</td>
<td>A-Weighted SPL= 13.0</td>
</tr>
<tr>
<td>Src= 97.6</td>
<td>Gm= 0.6</td>
<td>Acf= 0.3</td>
<td>Atm= -15.6</td>
<td>Raw SPL= 26.7</td>
<td>A-Weighted SPL= 13.3</td>
</tr>
<tr>
<td>Src= 97.6</td>
<td>Gm= 0.6</td>
<td>Acf= 0.4</td>
<td>Atm= -19.5</td>
<td>Raw SPL= 22.8</td>
<td>A-Weighted SPL= 11.9</td>
</tr>
<tr>
<td>Src= 96.6</td>
<td>Gm= 0.6</td>
<td>Acf= 0.5</td>
<td>Atm= -24.4</td>
<td>Raw SPL= 17.0</td>
<td>A-Weighted SPL= 8.4</td>
</tr>
<tr>
<td>Src= 95.6</td>
<td>Gm= 0.7</td>
<td>Acf= 0.6</td>
<td>Atm= -31.6</td>
<td>Raw SPL= 8.8</td>
<td>A-Weighted SPL= 2.2</td>
</tr>
<tr>
<td>Src= 93.6</td>
<td>Gm= 0.7</td>
<td>Acf= 0.9</td>
<td>Atm= -42.6</td>
<td>Raw SPL= -4.1</td>
<td>A-Weighted SPL= -8.9</td>
</tr>
<tr>
<td>Src= 91.6</td>
<td>Gm= 0.8</td>
<td>Acf= 1.2</td>
<td>Atm= -56.4</td>
<td>Raw SPL= -19.8</td>
<td>A-Weighted SPL= -23.0</td>
</tr>
<tr>
<td>Src= 89.6</td>
<td>Gm= 0.9</td>
<td>Acf= 1.6</td>
<td>Atm= -78.5</td>
<td>Raw SPL= -43.8</td>
<td>A-Weighted SPL= -45.7</td>
</tr>
<tr>
<td>Src= 86.6</td>
<td>Gm= 1.0</td>
<td>Acf= 2.3</td>
<td>Atm= -112.5</td>
<td>Raw SPL= -80.7</td>
<td>A-Weighted SPL= -81.5</td>
</tr>
<tr>
<td>Src= 84.6</td>
<td>Gm= 1.1</td>
<td>Acf= 3.2</td>
<td>Atm= -157.9</td>
<td>Raw SPL= -128.1</td>
<td>A-Weighted SPL= -128.1</td>
</tr>
<tr>
<td>Src= 84.6</td>
<td>Gm= 1.2</td>
<td>Acf= 4.6</td>
<td>Atm= -225.2</td>
<td>Raw SPL= -195.3</td>
<td>A-Weighted SPL= -194.7</td>
</tr>
<tr>
<td>Src= 85.6</td>
<td>Gm= 1.2</td>
<td>Acf= 6.8</td>
<td>Atm= -331.6</td>
<td>Raw SPL= -300.7</td>
<td>A-Weighted SPL= -299.7</td>
</tr>
<tr>
<td>Src= 85.6</td>
<td>Gm= 1.1</td>
<td>Acf= 9.6</td>
<td>Atm= -467.9</td>
<td>Raw SPL= -437.0</td>
<td>A-Weighted SPL= -435.8</td>
</tr>
<tr>
<td>Src= 83.6</td>
<td>Gm= 1.0</td>
<td>Acf= 13.6</td>
<td>Atm= -661.5</td>
<td>Raw SPL= -632.7</td>
<td>A-Weighted SPL= -631.4</td>
</tr>
<tr>
<td>Src= 81.6</td>
<td>Gm= 0.9</td>
<td>Acf= 19.3</td>
<td>Atm= -938.8</td>
<td>Raw SPL= -912.2</td>
<td>A-Weighted SPL= -911.0</td>
</tr>
<tr>
<td>Src= 79.6</td>
<td>Gm= 1.0</td>
<td>Acf= 27.5</td>
<td>Atm= -1399.6</td>
<td>Raw SPL= -1314.9</td>
<td>A-Weighted SPL= -1313.9</td>
</tr>
<tr>
<td>Src= 78.6</td>
<td>Gm= 1.1</td>
<td>Acf= 38.2</td>
<td>Atm= -1859.9</td>
<td>Raw SPL= -1836.1</td>
<td>A-Weighted SPL= -1835.6</td>
</tr>
<tr>
<td>Src= 76.6</td>
<td>Gm= 0.9</td>
<td>Acf= 53.2</td>
<td>Atm= -2587.5</td>
<td>Raw SPL= -2565.8</td>
<td>A-Weighted SPL= -2565.9</td>
</tr>
<tr>
<td>Src= 73.6</td>
<td>Gm= 1.1</td>
<td>Acf= 74.9</td>
<td>Atm= -3641.6</td>
<td>Raw SPL= -3622.7</td>
<td>A-Weighted SPL= -3623.8</td>
</tr>
</tbody>
</table>

Overall A-weighted SPL = 19.7

- SPL: SoundDist=14770.9 Retarded Time=50654.1 AspectAngle=177.42
- Frequency Independent: Geom= -45.8 LOS= 0.0 SZ= -10.0

Figure 3.0-4 Output log file
When comparing SENM output against real world microphone data, the SPL values for each frequency for a specific time are used. The time used most often is the time the peak AL occurs. An example showing how real world measurement data can be compared to SENM output can be seen in Figure 3.0-5. The example compares the SPL values in the log file for each frequency at the peak AL time with microphone output, also from the peak AL time.

The output file Prefix.plpos shown in Figure 3.0-6 stores the aircraft's positions at each simulation time step. One useful function of this file is to find the position of the aircraft at the time of the peak AL. The two other output files, Prefix.map and Prefix.avg are binary files and are not shown as examples. They are described in section 2.4.

**SPL Comparison**

![SPL Comparison Graph]

**Figure 3.0-5 Sample Analysis**

<table>
<thead>
<tr>
<th>Frequency Band #</th>
<th>50696.0</th>
<th>50696.5</th>
<th>50697.0</th>
<th>50697.5</th>
<th>50698.0</th>
<th>50698.5</th>
<th>50845.0</th>
<th>50845.5</th>
<th>50846.0</th>
<th>50846.5</th>
<th>50847.0</th>
<th>50847.5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>-11628</td>
<td>-11588</td>
<td>-11548</td>
<td>-11508</td>
<td>-11467</td>
<td>-11427</td>
<td>4817</td>
<td>4948</td>
<td>5081</td>
<td>5213</td>
<td>5347</td>
<td>5481</td>
</tr>
<tr>
<td></td>
<td>405</td>
<td>385</td>
<td>365</td>
<td>345</td>
<td>325</td>
<td>306</td>
<td>-271</td>
<td>-270</td>
<td>-269</td>
<td>-267</td>
<td>-266</td>
<td>-264</td>
</tr>
<tr>
<td></td>
<td>399</td>
<td>396</td>
<td>393</td>
<td>391</td>
<td>389</td>
<td>387</td>
<td>309</td>
<td>309</td>
<td>310</td>
<td>313</td>
<td>319</td>
<td>327</td>
</tr>
</tbody>
</table>

**Figure 3.0-6 Output plpos file**
4.0 DESCRIPTION OF THE GRAPHICAL MODEL AND EXECUTION INSTRUCTIONS

The graphical model is a tool for animation and visualization of the output from the computational model. As stated earlier, it is based on the Motif 1.2.3 tool kit and therefore runs under the Motif window manager for X.

Execution of the graphical model follows the standard model of all event driven X-windows programs. Interaction with the model is through pointer or keyboard events that trigger some action in the program. As such the following information will describe the current mouse and keyboard operations for interacting with the graphical model.

The execution of the graphical model begins by entering "Xnoise" on the command line. At that point, a main program window will pop up. The Xnoise main program window consists of the standard Motif window manager frame with window menu button, title area, minimize button, and maximize button. Additionally, within the window frame, are the menu bar, empty display area, and simulation "Time" display area initialized to 0.0 and grayed-out. These items are shown below in Figure 4.0-1.

![Figure 4.0-1 Main Window](image-url)
As a Motif compliant application, Xnoise follows the conventions of the Motif window manager for interacting with the application at the top-level. Therefore, using the pointer on various parts of the frame you can:

- Display the Window Menu by clicking the first pointer button on the Window Menu command button, the button located in the upper-left corner of the frame (decorated with a rectangle). This menu provides seven items that can be used to manage the window and its icon and provide the same results as if other parts of the window frame (described below) were accessed. The application can be closed or killed by double-clicking on the Window Menu command button.

- Iconify the window by clicking the first pointer button on the Minimize command button, the left-hand button in the upper-right corner of the frame (decorated with a small square). To convert the icon back to a window, double click on the icon with the first pointer button.

- Maximize the window to its full size by clicking the first pointer button on the Maximize command button. This button is to the right of the Minimize button and is decorated with a larger square. To convert the window back to its original size, click on the Maximize button again.

- Raise a window to the foreground by clicking the first pointer button on any part of the window frame except the three command buttons (Window Menu, Minimize Maximize).

- Move the window by pressing and holding down the first pointer button on any part of the title area (except the command buttons), dragging the window outline to a new location, and releasing the pointer button. To move an icon, place the pointer on the icon, press and hold down the first pointer button, drag the icon outline to the new location, and release the pointer button.

- Resize the window by moving the pointer into one of the resize borders or corners, pressing and holding the first pointer button, and dragging the border or corner in the direction you want. A window outline tracks the resize operation. Release the pointer button to redraw the window in the new size.
An example of the Window menu and the locations of command buttons are shown below in Figure 4.0-2.

![Window Menu and Command Buttons](image)

*Figure 4.0-2 Window Attributes*

Additionally, the Xnoise application uses "tear-off" menus which you can post in sub-windows that remain on display until removed. Posting the sub-window is accomplished by clicking the first pointer button on the "perforated" or dotted line in the menu. The tear-off menu behaves just like a main window except it cannot be minimized or maximized. All other Motif window attributes behave as described above. The tear-off menu also has a Window menu accessed by the same Window menu button in the upper-left hand corner. All main window menus in the Xnoise application use tear-offs, therefore making it easy to access frequent menu items. An example of a tear-off menu is shown below in Figure 4.0-3.
As stated above, the main program window includes a menu bar. This menu bar consists of five buttons: File, Edit, View, Options, Help. These buttons on the menu bar provide lower level menus for interacting with the application. These lower level menus are accessed by clicking the first pointer button on the text of the menu you wish to access. Currently, only the File, View, and Options submenus have menu items that interact with the application. The Edit and Help submenus have place holders for future items that will be added.

The File menu is shown in Figure 4.0-4 and is capable of being posted as a tear-off menu. It consists of two menu button items: Open and Exit.
The **Open** menu button is the primary means of accessing the display capabilities of the application. If you do not open a file, any attempt to access other main menu items will result in the posting of an Information Dialog Box (IDB) indicating that you must first open a file (Figure 4.0-5). You dismiss this dialog box by clicking the first pointer button on **OK**.

![Figure 4.0-5 Information Dialog Box](image)

When the **Open** menu button is selected, a File Selection Dialog Box (FSDB) is posted in the center of the Xnoise display window (Figure 4.0-6).
The FSDB provides an interactive means to select files. As a default, the file selection filter is set to list all files with the parameter file extension "parm". The parameter files listed in the Files window of the FSDB are the same as the parameter files from the computational runs. A parameter file can be selected and opened by either double-clicking with the first pointer button on the desired file or by highlighting with a single click of the first pointer button the desired file and then a single click on the Open button in the FSDB. If the desired file is not displayed in the Files window, you can traverse the directory tree by double-clicking on the ../ entry in the Directories window. In the event that a selected file cannot be found or read, an Error Dialog Box (EDB) is posted indicating the nature of the error (Figure 4.0-7).

![Figure 4.0-7 Error Dialog Box](image)

Once a file is properly selected and opened, Xnoise performs a number of actions that will result in the display of a Aweighted Sound Pressure Level (AL) map. As you might recall the AL map file contains the AL value for each grid point per each time step throughout the computational simulation.

The first action is that the application changes the pointer cursor to a watch cursor to indicate a lengthy action is taking place. Additionally, all keyboard and pointer events are disabled to prevent the user from taking any actions during the display of the first map image. Next, the parameters file from the computational run is opened, read, and stored for later access by Xnoise. Memory is then dynamically allocated for the storage and manipulation of the AL map file and the values from the file are read and stored. As additional visual feedback to the user, an IDB (Figure 4.0-8) is posted indicating the AL map file is being read.
Once the AL values are read, they are then converted to color levels for display. The color levels indicate the intensity of the AL in dBA. Values displayed range from 25 to 125 dBA and each value is represented by a unique color. The color spectrum starts at blue for the lowest AL value, goes through green and yellow, and finally ends at red for the highest AL value. As additional visual feedback to the user, an IDB (Figure 4.0-9) is posted indicating the AL map file is being converted.
When the AL values are converted to color levels, Xnoise sets the Time window to the beginning of the simulation time, scales the information to fill the display, and puts the first AL map image into the display window (Figure 4.0-10). At this point, the cursor is changed back to its original shape and event control is returned to the user.
Once the first AL map image is displayed, the user can then access the menu items in the View and Options menus. The View menu is shown below in Figure 4.0-11 and is capable of being posted as a tear-off menu. The View menu provides a means to step through and animate the computational output, displaying each AL map in the simulation. The menu item buttons on the View menu include: First AL Map, Last AL Map, Step Forward, Step Backward, Run Forward, and Run Backward.

![Figure 4.0-11 View Menu](image)

The First AL Map menu button will bring the first AL map image to the window display and set the Time display window to the beginning of the simulation time. It provides a quick means to return to the beginning of the AL map images from whatever image you are currently viewing. In the event that the current image in the display is the first AL map image, an IDB is posted (Figure 4.0-12).
The **Last AL Map** menu button will bring the last AL map image to the window display and set the **Time** display window to the simulation time prior to the aircraft removal from the computational model. It provides a quick means of jumping to the end of the AL map images from whatever image you are currently viewing. In the event that the current image in the display is the last AL map image, an IDB similar to that posted for the first image is displayed. Figure 4.0-13 shows the result of pressing the **Last AL Map** menu item for the current parameter file.

![Figure 4.0-13 Last AL Map Image](image)
The Step Forward and Step Backward menu buttons provide a means to interactively move forward and backward within the simulation from your current location in the AL map file. Each displays either the next or previous AL map image and the simulation time associated with the map image. The step size for forward or back is initially set to the simulation step time in the parameters file. However, the step size can be changed from the Options menu that will be discussed below. The final menu items are Run Forward and Run Backward and it provides an animation capability by stepping through each of the AL map images in a rapid fashion. As with the Step Forward and Step Backward menu items, the time step of the animation can be controlled from the Options menu.

The Options menu controls a number of items associated with viewing the AL map images. These items include the minimum AL level displayed, time-step playback size, contour plotting of terrain, and proportionality of the image in the display window. All these options can be accessed through the Options menu (Figure 4.0-14).

![Figure 4.0-14 Options Menu](image-url)
The first menu item under the **Options** menu is the **Floor** menu button. When the **Floor**
menu item is selected, a dialog box is popped up that contains a scale slider for setting the
minimum displayed AL value. The slider bar has a minimum value of 25 dBA and a maximum
value of 125 dBA (Figure 4.0-15) and is mapped to the color levels in the display window.

![Figure 4.0-15 Sound Floor Range](image)

The user sets the minimum AL value to be displayed by holding the first pointer button
down over the slider bar and dragging it to the right or left to increase or decrease the value and
then releasing the first pointer button. The screen will clear and then the display window will be
redrawn at the minimum AL value. The AL floor remains in effect until changed or a new file is
opened. By default, the AL floor is set to zero to display the entire AL map. Constant visual
feedback of the minimum displayed AL value is provided by a numeric indicator above the slider
bar.

An alternative means to move the minimum value one unit at a time is to simply click the
first mouse pointer button on the slider scale. To increase the AL floor one unit at a time, click
the first pointer button on the slider scale to the right of the slider bar. To decrease the AL floor
one unit at a time, do the opposite of the above. Figure 4.0-16 shows an example of the last
image from the opened AL map file with the sound floor set to 75 dBA.
As mentioned above, the time-step for displaying the AL map images can be modified. This is accomplished through the **Speed** menu item. When the **Speed** menu button is selected, a dialog box is popped up and contains five toggle buttons representing multiples on the computational time-step. For example, the computational time-step is 0.5 seconds. To display AL map images of two second intervals, the **4x** toggle would be selected. The time-step multiple remains in effect until changed by the user. The default multiple is one time the computational simulation time-step. Figure 4.0-17 shows an example of the **Speed** dialog box.

![Figure 4.0-17 Speed Dialog](image)

The last menu item under the **Options** menu is **Toggles**. Selection of this menu button will pop up a dialog box containing four toggle buttons for turning on and off overlays on the AL maps in the display window. Currently the **Aircraft** button is not active but is planned for the next release. However, the **MicroPhones**, **Terrain**, and **Proportional** buttons are active (Figure 4.0-18.).
The **Terrain** toggle button turns on and off an overlay of terrain contours on the AL map image. When the button is toggled on, the display window is cleared and the terrain contours are calculated from the terrain database file listed in the parameters file. The previous version of the program did not allow for storage of the calculated contour vectors. This situation has been rectified and as a result, it is now possible to display the terrain contours overlay in conjunction with the playback animation of the AL maps. In fact, all overlays can be used in conjunction with the animation of the AL maps without any loss in program performance. Figure 4.0-19 shows an example of a terrain file overlaid on a AL map.
By default, AL map images are scaled to fill the entire display. This is the case even if the area of interest is smaller than the display window. For example, if the area of interest represented a grid of 400 horizontal grid points by 100 vertical grid points, Xnoise would scale the AL map image to make 100 vertical grid points fill the vertical portion of the display window. Consequently, a AL map image may appear distorted in either the horizontal or vertical direction from what one would expect. To change the default and force the AL map image to be displayed proportionally in relation to the grid size, the Proportional toggle button is selected. When selected, the display window is cleared and the image is resized so that either the horizontal or vertical direction will fill the display window and the other direction will be sized to maintain the same proportion as the original input grid. Figure 4.0-20 shows an example of the Proportional toggle button in operation on the current open file. The original image has
been rescaled to eliminate the previous vertical distortion and give a true rendering of the shape of the acoustic field.

Figure 4.0-20 AL Map Image in Proportional Mode
The Microphones toggle button is the newest feature to the program. It allows the user to interactively turn on and off the display of an overlay of microphone locations from the input parameters file. When the button is toggled on, the display window is updated with whatever label was assigned to the microphones in the input parameter file. Figure 4.0-21 shows an example of a set of eight microphones overlayed on the AL map along with the terrain contours. The microphones are labeled with the numbers one through eight as assigned in the input parameter file.

Figure 4.0-21 AL Map Image with Microphones and Terrain Contour Overlays